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Note

Before using this information and the product it supports, read the information in “Notices” on page 47.

This edition applies to version 3.5.2 of IBM FileNet Process Analyzer (product number 5724-R76) and to all
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subsequent releases and modifications until otherwise indicated in new editions.
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Typographical Conventions

This document uses the conventions in the following table to distinguish elements of text.

NOTE  Some path names in this document that are identical (except for the directory-separator character) 
on both UNIX® and Windows® platforms are specified in UNIX syntax only (that is, with forward-slash 
directory separators).

WARNING  This document contains examples of text to be typed on a command line. Be sure to manually 
type the command, rather than copying and pasting it from this document. Otherwise, your command line 
may contain unrecognized characters and will not execute properly.

Convention Usage

UPPERCASE Environment variables, status codes, utility names.

Bold Program names and selected terms such as command 
parameters or environment variables that require emphasis.

Bold Gray Clickable user-interface elements (such as buttons).

Bold Olive Paths and file names. 

Italic User-supplied variables and new terms introduced in text, 
names of additional documents (such as FileNet P8 Platform 
Installation and Upgrade Guide).

<italic> User-supplied variables that replace everything between and 
including the angle bracket delimiters (< and >).

Monospace Code samples, examples, display text, and error messages.
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE
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Revision Log

The following table identifies changes made to this document since the IBM® FileNet® Process 
Analyzer 3.5.0 release.

Date Revision

03/08
(3.5.2) 

Process Analyzer 3.5.2 release.

Added section “Access IBM FileNet Documentation, Compatibility Matrices, and Fix 
Packs” on page 10.

Added support for MS SQL Server 2005 in “To install and configure Microsoft SQL 
Server 2005” on page 19, in “To install SQL Server Client 2005” on page 21, and 
throughout the document.

Added upgrade task “(Optional) Upgrade MS SQL Server 2000 to version 2005.” on 
page 41.

4/3/06 The topic “Upgrade Process Analyzer Engine” on page 39 was modified to add a 
step to verify that all events have been published before starting the upgrade.  
Resolves DTS 174145.

3/15/06 The topic “Install Process Analyzer Engine” on page 23 was modified to add 
MSSQLOLAPServer to table of services for logon as PA Administrator if remote 
DB.  Resolves DTS 173286.

12/5/05 
(3.5.1a)

The topic “To install and configure Microsoft SQL Server 2000” on page 17 was 
modified to indicate that either case-sensitive or case-insensitive collation is 
supported.

09/15/05
(3.5.1)

Added information related to Service Pack 1.

The topic “Installation Planning Considerations” on page 10 was modified to add a 
note indicating that IBM does not support the use of a single Process Analyzer 
for both production and simulation use..
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE
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About this Document

Installation by a FileNet Certified Professional (FCP) Recommended. For more information on the 
FCP program, contact your IBM service representative.

Every effort has been made to provide you with complete installation instructions. If information 
becomes available after the creation of the documentation release from which you accessed this 
guide, we will provide an updated version of the guide. To download this guide from the IBM 
support page, see “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on 
page 10. 

Send your comments by e-mail to comments@us.ibm.com. Be sure to include the name of the 
product, the version number of the product, and the name and part number of the book (if 
applicable). If you are commenting on specific text, include the location of the text (for example, a 
chapter and section title, a table number, a page number, or a help topic title).

This guide provides instructions for installing and/or upgrading the IBM FileNet Process Analyzer 
(PA) to its current released version. Be aware that each release of a FileNet P8 component or 
expansion product may have multiple Service Packs, Hotfix Packs, or patches available for 
installation, each with potentially different dependencies and installation requirements. Therefore, 
before you attempt to install or upgrade PA, review the list of releases and their associated 
dependencies in the P8-3.5.x / P8-3.6.x / P8-3.7.x Fix Pack Dependency/Compatibility Matrix 
(p835xPatchDependency.xls) document on the IBM support page (www.ibm.com/software/data/
support/). See “Access IBM FileNet Documentation, Compatibility Matrices, and Fix Packs” on page 10.

http://www.ibm.com/software/data/support/
http://www.ibm.com/software/data/support/
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Installation Planning and Procedures

This installation section contains the following major topics:

• “Installation Planning Considerations” on page 10

• Task 1 “Install Process Analyzer documentation” on page 16

• Task 2 “Install Microsoft SQL Server” on page 17

• Task 3 “Install Microsoft SQL Server Client software” on page 21

• Task 4 “Install Process Analyzer Engine” on page 23

• Task 5 “Install Process Analyzer Client” on page 29

• Task 6 “Install Process Analyzer Software Updates” on page 33
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Installation Planning Considerations
This section lists details that will help you prepare your environment for the installation of PA on a 
FileNet P8 system. In many cases, the items are links to more detailed information which will help 
you plan a system rollout of this expansion product. Review this information thoroughly before you 
start to set up associated FileNet P8 components or required third-party software.

Access IBM FileNet Documentation, Compatibility Matrices, and Fix 
Packs
To access documentation for IBM FileNet products

1. Navigate to the Information Management support page (www.ibm.com/software/data/support).

2. Select the appropriate FileNet product from the Select a category list. 

3. From the Product Support page, under Learn, click Product documentation.

4. From the Product Documentation page:

a. If necessary, click the Doc Link for the appropriate component product to display the docu-
ment list.

b. Click the icon in the appropriate release column to access the document you need.

To access compatibility matrices and fix packs for IBM FileNet products

1. Navigate to the Information Management support page (www.ibm.com/software/data/support).

2. Select the appropriate IBM FileNet product from the Select a category list.

3. From the Product Support page, under Download, click Fix Packs by version.

4. From the Fix Pack page:

a. Click Matrix to access the compatibility matrix.

b. Click the release number to access the fix pack you need.

Gather Required Documentation
Before you begin installing the software, retrieve the following documents.

NOTE  For general instructions on how to navigate to this and other IBM FileNet product 
documentation on the IBM web site, see “Access IBM FileNet Documentation, Compatibility Matrices, 
and Fix Packs” on page 10.

• IBM FileNet Process Analyzer Installation and Upgrade Guide. This document; provides details for 
the installation, upgrade, and configuration of the core components for the FileNet P8 system.

• IBM FileNet P8 Hardware and Software Requirements. This document provides details for all 
FileNet P8 system components, as well as the minimum supported levels of third-party 
software components. The information throughout the IBM FileNet Process Analyzer 
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE
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Installation and Upgrade Guide assumes you have met all applicable requirements listed in 
that document. 

• IBM FileNet P8 Platform Installation and Upgrade Guide. This document provides details for the 
installation, upgrade, and configuration of the core components for the FileNet P8 system.

• IBM FileNet P8 Platform Release Notes. This document provides details on new features, known 
issues, and resolved problems.

• IBM FileNet P8 Platform Troubleshooting Guide. This document provides troubleshooting 
information on all aspects of the product.

Software Requirements

Active Directory
(If you are using Active Directory) The Microsoft® SQL Server must be in the same Active 
Directory forest as the PA server.

Server Time Synchronization
Ensure that the following components are in the same time zone and synchronized to the same 
time: 

• PA Engine

• PA database

• Process Engine (PE) 

Ports
• See the FileNet P8 Platform Installation and Upgrade Guide for information on required ports 

for PA and other FileNet P8 system components.

• PA requires a static TCP/IP port number for the PA database instance. 

The port number is required during PA installation. 

Process Analyzer
• There are two typical use cases for PA.

– Production PA is for analyzing data from a production system. In addition, production PA 
can provide production input data to Process Simulator (PS). 

– Simulation PA is for analyzing simulation data, and it is populated with output from 
Process Simulator.

• Before you install PA, be aware that IBM FileNet does not support:
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE
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– Using a single PA for both production and simulation activity, or storing both production 
data and simulation data in the same database.

– Collocating PS and PA where PA is used in a production context. Collocation of PS and PA 
is supported where PA is used in a simulation context.

Database
• The PA setup program automatically creates the following two databases. 

– The PA database (VMAEDM).

– The OLAP database (VMAE). 

NOTE  If PA is configured with a named database instance, the name of the OLAP database is 
VMAE_<database_instance_name>. For example, if the database instance name is “inst1,” 
the OLAP database name is VMAE_inst1. For more information, see “Instance name.” on 
page 17.

• Ensure that PA database files are on an NTFS-formatted drive. 

The PA database files can grow large over time. To allow the file sizes to grow beyond 4GB, 
the database file must be located on a drive that is formatted as NTFS.

• You can use a local or remote database for PA.

The database engine is local if it is installed on the same server that you install the PA Engine 
software. The database is remote if it is on a separate server from PA using that database. 

• For performance reasons FileNet does not recommend collocating the PE and PA databases.

Additional software requirements
Follow the installation or upgrade tasks provided in this manual to install a new 3.5.2 PA or 
upgrade an existing 3.5.1 PA to 3.5.2. After your system is successfully running 3.5.2, follow the 
procedures in “Install Process Analyzer Software Updates” on page 33 to apply any required fix packs.
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE
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Security

Users required for MS SQL installation
To install SQL Server, you need a local user with administrator privileges on the computer where 
the database will be installed.

Users required for Process Analyzer installation
Create or identify the following user:

<PA Installer>

This user must:

• be local or domain Windows user belonging to the local Administrators group on the computer 
where PA Engine will be installed. 

NOTE  If the database is remote from the PA server, you must use a domain user.

• be added as a SQL Login user with the following MS SQL server roles: 

– Database Creators

– Bulk Insert Administrators

– System Administrators

• have administrative privileges on the Online Transaction Analysis Processing (OLAP) 
database.

For instructions, see “To create a Windows user with administrative privileges on the Online 
Transaction Analysis Processing (OLAP) database.” on page 14.

Users required at runtime
Create or identify the following users:

• <PA Administrator>

This user must:

– be a local or domain Windows user who has write access on the local computer (where the 
PA Engine will be installed).

– have administrative privileges on the Online Transaction Analysis Processing (OLAP) 
database.

For instructions, see “To create a Windows user with administrative privileges on the Online 
Transaction Analysis Processing (OLAP) database.” on page 14.

• <PA DB Administrator>

This user must be a MS SQL database user with:
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE
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– the following MS SQL database privileges on the SQL Server PA database (VMAEDM) 
database:

• db_owner

• ddl_admin

– the following MS SQL database role on the SQL Server PA database (VMAEDM) data-
base:

• Bulk Insert Administrators

• <PA Client Database User>

The Windows (local or domain) user you use to log on to the PA Client server must have 
permission to access the OLAP cubes on the Process Analyzer database server for the client 
to be able to connect to the PA OLAP database (VMAE).

For more information on how to configure the <PA Client Database User> see “To grant access 
rights to the Process Analyzer OLAP database” on page 29 and “Configure the PA Client.” on page 31.

Depending on how your environment is set up, either of the following scenarios could apply:

– (If the database server and PA Client server belong to the same LDAP domain) Give the 
domain user or group access to the OLAP cubes on the database server

– (If the database server and PA Client server do not belong to the same domain) Create a 
duplicate of the client user on the database server, and give the user access to the OLAP 
cubes.

CAUTION  When you create the duplicate user, you must create a user with the same user 
name and password as is used for the Windows logon to the PA Client server. 

To create a Windows user with administrative privileges on the Online Transaction Analysis 
Processing (OLAP) database.

• (For MS SQL Server 2000) Add the user as a member of the OLAP Administrator group. 

NOTE The OLAP Administrator group assignment will take place during MS SQL installation. 
See “Verify that the <PA Installer> user has been given administrative privileges on the Online 
Transaction Analysis Processing (OLAP) database.” on page 20. 

• (For MS SQL Server 2005) Add the user to the server role within SQL Server 2005 Analysis 
Services (SSAS)

a. Open SQL Server Management Studio. 

b. In the Connect to Server window, connect to the instance of SQL Server 2005 Analysis Ser-
vices that you are using.

c. In Object Explorer, right-click your SQL Server 2005 Analysis Services instance name, and 
select Properties.

d. On the Analysis Services Properties page, in the Select a page pane, click Security. 

NOTE  Users and Groups that are members of the server role will appear in a list.
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE
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e. Click Add. 

f. In the Select Users or Groups page, go to the “Enter the object names to select” field and 
enter the name of the Shared Services Provider (SSP) account that you are adding to the 
server role. 

NOTE  Click Check Name to verify that the account exists.

g. Click OK.
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE
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Task 1: Install Process Analyzer documentation
Process Analyzer is an expansion product on IBM FileNet P8 Platform; therefore you must add the 
associated PA documentation to an existing installation of the IBM FileNet P8 Platform Help. This 
action makes PA help available to your users and enables context-sensitive help from the product 
user interface. 

For details and instructions on installing expansion product documentation, see the latest version 
of the IBM FileNet P8 Platform Installation and Upgrade Guide. Pay special attention to the “Install 
expansion product documentation” subtopic in the “Install IBM FileNet P8 documentation (<your 
application server>).” task

CAUTION  You can install only the 3.5.2 version of PA documentation on an existing IBM FileNet 
P8 Platform 3.5 documentation server. 
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Task 2: Install Microsoft SQL Server
This task uses third-party software. Be sure to read all pertinent documentation from the third-
party software vendor. Contact your system/network/database administrator with third-party 
vendor or environment questions before you continue.

Depending on your configuration, complete either of the following procedures:

• “To install and configure Microsoft SQL Server 2000” on page 17.

• “To install and configure Microsoft SQL Server 2005” on page 19.

NOTES

• Configure the MS SQL Server database for Mixed Mode authentication.

• The PA setup program automatically creates the PA database. No manual steps are required.  

• During the MS SQL Server installation, record the values for the following settings. You will 
use this information during PA Engine installation in “(Remote Database) Specify the Database 
Configuration Parameters” on page 25 or “(Local Database) Specify the Database Configuration 
Parameters” on page 25.

– Server name.

– Instance name.

– Static TCP/IP port assigned to the database instance. See “Ports” on page 11.

– Name and password of the <PA DB Administrator> user that PA will use to access the data-
base. See “Users required at runtime” on page 13.

To install and configure Microsoft SQL Server 2000 

In addition to the following instructions, refer to Microsoft’s SQL Server 2000 installation 
instructions. 

1. Log on as a local user with administrator privileges on the computer where the database will be 
installed. See “Users required for MS SQL installation” on page 13.

2. Create a database instance for use by PA software, or verify that such an instance already 
exists. 

Use the Instance name you decided on in “Instance name.” on page 17.

3. Verify a Custom Microsoft SQL Server installation. 

4. On the Services Accounts dialog box, choose Use the same account. Under Service Setting, 
choose Use the Local System account.

5. Verify that the authentication is set to Mixed Mode. 

6. Provide an sa password for your site.
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE
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7. Select one of the following database collations:

• Dictionary order, case-insensitive, for use with 1252 Character Set (or any case-insensitive 
SQL Server collation). Case-insensitive collation is the Microsoft default and the setting most used 
in FileNet P8 environments (because it offers search results without regard to character case). 

• Dictionary order, case-sensitive, for use with 1252 Character Set (or any case-sensitive SQL 
Server collation). Select case-sensitive SQL Server collation only if you are sure your site requires 
(and will continue to require) searches that must differentiate upper-case from lower-case charac-
ters (in property choice lists, folder names, and so on.). 

CAUTION  Select your SQL Server collation setting carefully. Switching collation settings after 
installation can be difficult and time-consuming, especially if you want to switch from case-
sensitive to case-insensitive collation after significant user activity. Also, be aware that if you 
have a case-sensitive database and you want to perform a case-insensitive search 
programmatically or otherwise, you will likely encounter serious performance degradation on 
SQL Server because the database cannot use column indexes in these cases.

8. Define a static port number.

See “Ports” on page 11.

NOTE  If the PA database instance is the only instance on the server, you can accept port 
1433 (default value) in the TCP/IP port number box. Otherwise, you must assign a non-
conflicting static port number for the PA database instance. 

9. Install Microsoft SQL Server 2000 Analysis Services add-on.

FileNet PA does not require any specific configuration settings when you install Microsoft SQL 
Server 2000 Analysis Services. Refer to Microsoft’s SQL Server 2000 installation instructions.

CAUTION  If you are using a remote database for PA you must install Microsoft SQL Server 
2000 Analysis Services on both the database server and the PA server. See “Install Microsoft 
SQL Server 2000 Analysis Services add-on.” on page 21.

NOTE  This is an add-on to the SQL Server software included with the SQL Server media. 

10. Download and install any required Microsoft SQL Server 2000 Service Packs, as indicated in 
FileNet P8 Platform Hardware and Software Requirements.

11. Restart the server.

12. Add the <PA Installer> user to the OLAP Administrators group.

Depending on your environment, this can be done in either of the following two ways:

• Local database

Add the <PA Installer> user to the local OLAP Administrator group.

• Remote database

– (If the database server and PA Engine server belong to the same domain and <PA 
Installer> user is a domain user) Add the domain <PA Installer> user to the local OLAP 
Administrators group on every server on which you have installed Microsoft SQL 
Server 2000 Analysis Services.
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE
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– (If the database server and PA Engine server do not belong to the same domain) Cre-
ate a duplicate of the <PA Installer> user on the database server.

Using the local user management tool, create a user with the same name and 
password as the <PA Installer> user created on the PA server.

Add the <PA Installer> user to the local OLAP Administrator group on every server on 
which you have installed Microsoft SQL Server 2000 Analysis Services.

13. (If the PA database will be remote from the PA Engine) Continue with “To install SQL Server Client 
2000” on page 21. 

14. (If the database will be local) Continue with Task 4 “Install Process Analyzer Engine” on page 23.

To install and configure Microsoft SQL Server 2005 

In addition to the following instructions, refer to Microsoft’s SQL Server 2005 installation 
instructions. 

1. Log on as a local user with administrator privileges on the computer where the database will be 
installed.

2. In the Components to Install screen, at a minimum, select the following components:

• SQL Server Database Services

• Analysis Services

• Workstation Components, Books Online and development tools

3. In the Instance Name screen, create a database instance for use by PA software, or verify that 
such an instance already exists. 

4. In the Service Account screen, choose Use the built-in System account, and select Local 
System from the drop-down menu.

5. In the Authentication Mode screen:

• Verify that authentication mode is set to Mixed Mode. 

• Provide an sa password for your site.

6. In the Collation Settings screen:

Select one of the following database collations:

• Dictionary order, case-insensitive, for use with 1252 Character Set (or any case-insensitive 
SQL Server collation). Case-insensitive collation is the Microsoft default and the setting most used 
in FileNet P8 environments (because it offers search results without regard to character case). 

• Dictionary order, case-sensitive, for use with 1252 Character Set (or any case-sensitive SQL 
Server collation). Select case-sensitive SQL Server collation only if you are sure your site requires 
(and will continue to require) searches that must differentiate upper-case from lower-case charac-
ters (in property choice lists, folder names, and so on.). 

CAUTION  Select your SQL Server collation setting carefully. Switching collation settings after 
installation can be difficult and time-consuming, especially if you want to switch from case-
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE
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sensitive to case-insensitive collation after significant user activity. Also, be aware that if you 
have a case-sensitive database and you want to perform a case-insensitive search 
programmatically or otherwise, you will likely encounter serious performance degradation on 
SQL Server because the database cannot use column indexes in these cases.

7. Define a static port number.

If the PA database instance is not the only instance on the server, you must assign a non-
conflicting static port number for the PA database instance using SQL Server Configuration 
Manager. For information, see your MS SQL Server Documentation.

8. Download and install the required Microsoft SQL Server 2005 Service Packs, as indicated in 
FileNet P8 Platform Hardware and Software Requirements.

9. Restart the server.

10. Verify that the <PA Installer> user has been given administrative privileges on the Online 
Transaction Analysis Processing (OLAP) database.

See the subtopic “(For MS SQL Server 2005) Add the user to the server role within SQL 
Server 2005 Analysis Services (SSAS)” of “To create a Windows user with administrative privileges 
on the Online Transaction Analysis Processing (OLAP) database.” on page 14

11. (If the PA database will be remote from the PA Engine) Continue with “To install SQL Server Client 
2005” on page 21. 

12. (If the database will be local) Continue with Task 4 “Install Process Analyzer Engine” on page 23.
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Task 3: Install Microsoft SQL Server Client software
If the PA database is remote from the PA server you must install the Microsoft SQL Server Client 
software on the PA Engine server.

Depending on your configuration, complete either of the following procedures:

• “To install SQL Server Client 2000” on page 21

• “To install SQL Server Client 2005” on page 21

To install SQL Server Client 2000

1. Install the SQL Server Client software.

a. Log on to the PA server with an account that has local administrator privileges.

b. Install the SQL Server Client software using the following options: 

• On the Installation Selection dialog box, choose Create a new instance of SQL Server, 
or install Client Tools. 

• On the Installation Definition dialog box, choose Client Tools Only. 

• Accept the defaults for the rest of the installation. 

c. When the installation is complete, click Start > Programs > Microsoft SQL Server > Client 
Network Utility.

d. On the DB-Library Options tab, clear Automatic ANSI to OEM conversion. 

2. Install Microsoft SQL Server 2000 Analysis Services add-on.

FileNet PA does not require any specific configuration settings when you install Microsoft SQL 
Server 2000 Analysis Services. Refer to Microsoft’s SQL Server 2000 installation instructions.

NOTE  This is an add-on to the SQL Server software included with the SQL Server media. 

3. Download and install the required Microsoft SQL Server 2000 Service Pack, as indicated in the 
FileNet P8 Platform Hardware and Software Requirements.

4. Verify the connection between the SQL Server Client installation and the database machine. 

At a command prompt type:

isql -E -S <servername>[\<instance_name>]

If the connection fails, be sure to resolve the problem before you proceed.

To install SQL Server Client 2005 

1. Install the SQL Server Client software.

a. Log on to the PA server with an account that has local administrator privileges.
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b. Install the SQL Server Client software using the following options: 

• In the Components to Install screen, select Workstation Components, Books Online 
and development tools.

• In the Feature Selection dialog, select the following Client Components:

– Connectivity Components

– Management Tools

• Accept the defaults for the rest of the installation. 

2. Download and install the required Microsoft SQL Server 2005 Service Pack, as indicated in the 
FileNet P8 Platform Hardware and Software Requirements.

3. Verify the connection between the SQL Server Client installation and the database machine. 

At a command prompt type:

sqlcmd -E -S <servername>[\<instance_name>]

If the connection fails, be sure to resolve the problem before you proceed.
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Task 4: Install Process Analyzer Engine
The installation of PA Engine requires changes to the configuration of PE, Application Engine 
(AE), and the database server, as well as on the computer where PA Engine is installed. The 
required configuration changes are presented below. Perform the tasks in the order they are 
presented.

Collect the required information
Before you install and configure the PA Engine, collect the information you will need during 
installation and configuration:

• The documentation server URL.

• The path to the Microsoft SQL Server JDBC driver install location. 

Depending on your configuration, see:

– See “To install the Microsoft SQL Server JDBC 2000 SP3 driver” on page 24 below.

– See “To install the Microsoft SQL Server JDBC 2005 1.2 driver” on page 24 below.

• The dedicated TCP/IP port number of the SQL Server database instance that the PA Engine 
will use.

– If you are installing SQL Server specifically for PA, you assigned the port number in “Define 
a static port number.” on page 20.

– If you are using a shared database instance, use the following procedure to determine the 
TCP/IP port number.

To find the port number on MS SQL Server 2000

i. On the SQL Server machine, open SQL Server Enterprise Manager.

ii. Display the database instance properties. 

iii. Click Network Configuration on the General tab. 

iv. Select TCP/IP in Enabled protocols, and click Properties. 

To find the port number on MS SQL Server 2005

i. Open the Microsoft SQL Server 2005 program group and open “Configuration Tools”.

ii. Then select “SQL Server Configuration Manager”.

iii. Expand the “SQL Server 2005 Network Configuration” leaf.

iv. Select “Protocols for MSSQLSERVER” or your Named Instance and double click “TCP/
IP” and select the “IP Address” tab.

v. In the TCP/IP Properties dialog box locate the “TCP Port” to see what TCP/IP port is 
being used.

• The name of the database server, if PA is configured with a remote database.

• The name of the database instance, if PA is configured with a non-default database instance.
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• (MS SQL 2005) The name of the Analysis Services instance, if Analysis Services is configured 
as a named instance. 

• The <PA DB Administrator> user ID and password for the PA database instance. This is the user 
created in “Users required at runtime” on page 13.

To install the Microsoft SQL Server JDBC 2000 SP3 driver 

If the Microsoft® SQL Server™ JDBC 2000 SP3 driver is not already installed on your system, 
download and install it from http://www.microsoft.com.

NOTE  To complete the PA installation, enter the path to the Microsoft® SQL Server™ JDBC 2000 
SP4 driver install location, see “Configure JDBC Driver” on page 26.

To install the Microsoft SQL Server JDBC 2005 1.2 driver 

If the Microsoft® SQL Server™ JDBC 2005 1.2 driver is not already installed on your system, 
download and install it from http://www.microsoft.com. 

NOTE  To complete the PA installation, enter the path to the Microsoft® SQL Server™ JDBC 2005 
1.2 driver install location, see “Configure JDBC Driver” on page 26.

To install Process Analyzer Engine Software 

1. Ensure that the database instance and analysis services that the PA Engine will use are run-
ning.

2. Log on as the <PA Installer> user, as defined in “Additional software requirements” on page 12.

3. Access the IBM FileNet Process Analyzer 3.5.2 software package.

4. Launch the Setup program (P8PA-3.5.2-Engine.exe, located in the PAEngine directory) to start 
the installation process.

In this screen... Perform this action...

License Agreement Review and accept the license agreement.

Specify Installation 
Location

Choose the destination drive and directory for Process Analyzer 
Engine software. 
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Specify the 
Documentation URL

Enter the Documentation URL, which is where the FileNet P8 
Platform Documentation is installed. Your entry must be in the 
following format:

http://<docserver:port#>/<ecm_help>

where: 

• docserver is the name of the Java™ web server.

• port# is the port number.

• ecm_help is the root folder of the documentation website. 
You can use multi-part root folders (for example,/docs/
ecm_help) if your application server supports them.

Specify Installation 
Location for Common 
Files 

Choose the destination directory for configuration files that will 
be shared with other FileNet P8 components.

Accept the default location or click Browse to change the 
location. 

Specify the Database 
Location

Indicate whether the database will be local or remote.

(Remote Database) 
Specify the Database 
Configuration 
Parameters 

Enter the name of the remote database server.

Enter the name of the instance to be used by PA. Leave the field 
blank if the default instance is to be used; otherwise enter the 
name of the instance that was created in “Install Microsoft SQL 
Server” on page 17.

Enter the static TCP/IP database port number that was 
assigned in “Install Microsoft SQL Server” on page 17.

Enter the database user name and password. This is the name 
of the <PA DB Administrator> created in “Users required at runtime” 
on page 13.

(Local Database) Specify 
the Database 
Configuration 
Parameters

Enter the name of the instance to be used by PA. Leave the field 
blank if the default instance is to be used; otherwise enter the 
name of the instance that was created in “Install Microsoft SQL 
Server” on page 17.

Enter the static TCP/IP database port number that was 
assigned in “Install Microsoft SQL Server” on page 17.

Enter the database user name and password. This is the name 
of the <PA DB Administrator> created in “Users required at runtime” 
on page 13.

In this screen... Perform this action...
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5. When the installation is complete, check the following log files to verify that the installation was 
successful.

• PAInstalllog.txt 

• PAServiceInstalllog.txt 

To configure PA 

1. Configure PA Engine.

a. From the Windows Start menu, navigate to Programs > FileNet P8 Platform > Process Ana-
lyzer > Process Task Manager.

b. Schedule data warehouse pruning and cube processing.

i. Select the Process Analyzer node and click the Scheduler tab.

ii. Choose the desired scheduling options for the cube processing and pruning events. 

(MS SQL 2005 only) 
Specify the Analysis 
Services Configuration 
Parameters

Enter the Analysis Services Instance Name. 

Leave blank if you are using the default instance. 

Install JVM If prompted, click Yes to install a JVM in the installation 
directory. 

Configure JDBC Driver Enter the Microsoft SQL Server JDBC 2000 SP3 or Microsoft 
SQL Server JDBC 2005 1.2 driver location.

Installation Summary Read and verify the installation summary information. 

Click Next if the information is correct, or click Back to make 
changes.

Complete the Installation When the installation is complete and the selected software has 
been started, click Finish to exit the installation program.

NOTE  In addition to installing PA Engine, the Setup program 
creates the PA and OLAP databases, see “Database” on page 12. 
This process could take several minutes to complete.

Specify Process 
Analyzer Usage 

Indicate whether PA will be used to:

• Analyze Production Data

• Analyze Simulation Data

• Analyze Production and Simulation Data.

In this screen... Perform this action...
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Configure any additional PA options on the remaining tabs as needed. For information on the 
PA tabs, see FileNet P8 Administration > Enterprise-wide Administration > Process Task Manager 
> Process Analyzer > Configure the Process Analyzer. 

c. Click Apply to save and apply your changes.

d. (If PA will use a remote database or PA is used for simulation) Configure the following ser-
vices to log on as the <PA Administrator>.  

e. (If PA will use a remote database) In Process Task Manager, specify the path for the shared 
Temp directory in UNC format.

i. On the PA Engine server, create a shared Temp directory and grant full access rights on 
the folder to the <PA Administrator>. Full access rights should be set on the Security and 
Sharing tabs.

ii. On PA Engine, navigate to Start > Programs > FileNet P8 Platform > Process Analyzer > 
Process Task Manager.

iii. Select the Process Analyzer node and then select the General tab.

iv. In the Temp Directory (UNC) field, enter the path to the shared Temp directory in UNC 
format. For example;

\\pa_server\temp

where “pa_server” is the name of the PA Engine server and “temp” is the name of the 
shared Temp directory you created.

2. Configure Application Engine.

a. Log on to Workplace.

If you defined the Process Engine Configuration Group on the LDAP tab of Process Task 
Manager during the Process Engine installation (see the “Configure the Process Engine 
LDAP Connection” task in the FileNet P8 Platform Installation and Upgrade Guide), you 
must log on as a member of either that group or the Process Engine Administrators Group, 
which was also defined on the LDAP tab, in order to initialize the isolated region.

b. In Workplace, click Admin and then click Process Configuration Console.

c. Select the icon of the appropriate VWService and click Properties on the toolbar.

On the Runtime Options tab, enable the Process Analyzer. For details see the IBM FileNet 
P8 Help topic Workplace > Admin Tools > Process Configuration Console > VWServices > 
Modify VWServices Properties > Set runtime options.

Service (MS SQL 2000) Service (MS SQL 2005) Location

Process Analyzer Services 
Manager

Process Analyzer 
Services Manager

Process Analyzer Engine

MSSQLServer SQL Server database server

MSSQLOLAPServer SQL Server Analysis 
Services

database server
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d. Click OK.

3. Configure Process Engine

a. From the Windows Start menu select Programs > FileNet P8 Platform >Process Engine > 
Process Task Manager.

b. If the Process Service is running, stop it by selecting the Process Service node and clicking 
Stop on the toolbar.

c. Select the Process Service node in the left panel, then select the Server Connections tab in 
the Properties panel.

d. Enter the host name of the Process Analyzer Engine and the Process Analyzer Port. The 
port you enter must match the Data port field in the Process Analyzer Task Manager - 
Advanced tab.

e. Click Apply to save your changes.

f. Start the Process Service by selecting the Process Service node and clicking Start on the 
toolbar.

g. Click Apply to save your changes.

4. Start the Process Analyzer services from the Process Task Manager by right-clicking Process 
Analyzer and selecting Start.
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Task 5: Install Process Analyzer Client
PA client software consists of out-of-the-box reports and templates. You can install PA client in a 
single location that multiple end users will access or on each end user workstation. The 
determining factors should be the number of end users who will access the reports and the 
sophistication of the end users.

To install prerequisite software

All PA Client machines and all end user workstations that will access the out-of-the-box reports or 
that will create reports must have: 

• Microsoft Excel with query analyzer (MS Query). 

For Excel version requirements, see the IBM FileNet P8 Platform Hardware and Software 
Requirements. See Microsoft documentation for instructions on how to install and configure 
Microsoft Excel.

• MS SQL Server add-ons:

– MS SQL Server 2000:

• Microsoft SQL Server 2000 PivotTable Services 

– MS SQL Server 2005:

• Microsoft Core XML Services (MSXML) 6.1 

• Microsoft SQL Server 2005 Analysis Services 9.0 OLE DB Provider.

NOTE  These add-ons are available for download from Microsoft. For details, see IBM FileNet 
P8 Platform Hardware and Software Requirements.

To grant access rights to the Process Analyzer OLAP database

Before anyone can use the system, you must grant access to the PA OLAP database. Use the 
Microsoft Analysis Manager (MS SQL Server 2000) or Microsoft SQL Server Management Studio 
(MS SQL Server 2005) to create roles and assign users. See “<PA Client Database User>” on 
page 14 and the online help for the MS SQL Server for more information and detailed instructions.

CAUTION  Use this procedure only as a guide to creating roles because each site's security 
requirements differ. 

1. Log on to the PA database server as the user with administrative rights on MS SQL Server.

2. (If the database server and PA Client server do not belong to the same domain) Create a 
duplicate of the client user on the database server.

Using the local user management tool, create a user with the same name and password as the 
user that will log on to the PA Client server.

3. Grant access rights to the Process Analyzer OLAP database

(MS SQL Server 2000) To grant access rights using Microsoft Analysis Manager

a. Go to Start > Microsoft SQL Server > Analysis Service > Analysis Manager.
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b. Expand Analysis Servers > <SQL Server name> > VMAE_<database_instance_name>.

NOTE  If you are using the default instance, no instance name is appended.

c. Right-click Database Roles and select Manage Roles.

d. Give the user access to the OLAP cubes.

i. Click New in the Database Role Manager screen that opens.

ii. Enter the following information:

• Role Name - Give a descriptive name for the role.

• Description - Describe how the role will be used.

• Enforce on - Select Client.

iii. Select the Membership tab.

iv. Click Add.

v. Select one of the following in the Add Users and Groups dialog box:

• The local user you just created.

• A domain user or group of users used to log on to the PA Client server.

vi. Click Add.

NOTE If you want to add more than one user or group, you must add them separately 
by repeating Step iv through Step vi.

vii. Click OK.

viii. Select the Cubes tab.

ix. Click Check All.

x. Click OK.

xi. Click Close in the Database Role Manager screen.

(MS SQL Server 2005) To grant access rights using Microsoft SQL Server Management Studio

a. Go to Start > Programs > Microsoft SQL Server 2005 > SQL Server Management Studio.

b. Connect to your analysis services instance.

c. Expand Databases > VMAE_<database_instance_name>.

NOTE  If you are using the default instance, no instance name is appended.

d. Right-click Roles and select New Role....

e. Give the user access to the OLAP cubes.

i. Enter the following information:

• Role Name - Give a descriptive name for the role.

• Description - Describe how the role will be used.
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ii. Set the database permissions for this role to be Full control (Administrator).

iii. Click OK.

To install and Configure Process Analyzer Client software interactively

1. Access the IBM FileNet Process Analyzer 3.5.2 software package.

Launch the Setup program (PA-3.5.2-Client.exe, located in the PAClient directory) to start the 
installation process..

2. Configure the PA Client.

NOTES  

• If you are logged in as a user that is not an <PA Client Database User>, you must now log out, and 
then log back in as a <PA Client Database User> before you proceed. 

In this screen... Perform this action...

License Agreement Review and accept the license agreement.

Specify Installation 
Location

Choose the destination drive and directory for PA Client 
software. 

Specify the 
Documentation URL

Enter the Documentation URL, which is where the FileNet P8 
Platform Documentation was installed. Your entry must be in the 
following format:

http://<docserver:port#>/<ecm_help>

where: 

• docserver is the name of the Java web server.

• port# is the port number.

• ecm_help is the root folder of the documentation website. 
You can use multi-part root folders (e.g., /docs/ecm_help) if 
your application server supports them.

Installation Summary Read and verify the installation summary information. Click 
Install if the information is correct, or click Back to make 
changes.

Complete the Installation When the installation is complete and the selected software has 
been started, click Finish to exit the installation program.

NOTE  Select “Run the Process Analyzer Client Configuration 
Tool” to have the tool automatically launch once the installation 
is complete.
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• Instead of storing the reports on each individual server, you can make them available to remote 
workstations by sharing the drive where the reports are located on the network, saving the reports 
to a network drive, or saving the reports to an object store.

If you take one of these actions, you must:

– Verify that the prerequisite software is installed on each end-user’s workstation. See 
“To install prerequisite software” on page 29 for details.

– Point the end users to the location of the reports.

– Point the end users to the Process Analyzer User Guide. See the IBM FileNet P8 Help 
topic Expansion Products > Process Analyzer > Process Analyzer User Guide (also avail-
able on the client server by navigating to Start > Programs > FileNet P8 Platform > 
Process Analyzer > Process Analyzer User Guide).

3. (If you need to start the configuration tool after you log on as a <PA Client Database User>) From 
the Start menu, navigate to Programs > FileNet P8 Platform > Process Analyzer > Process 
Analyzer Client Configuration Tool.

4. Enter the name of the server where the PA database is located. Depending on whether the PA 
Engine has a local or remote database, your entry is the name of either of the following:

• the server where the PA Engine software was installed

• the remote database server used by the PA Engine

5. Enter the Database Instance Name.

If the PA Engine uses a named instance of the database, enter the name of that instance. If 
the default database instance is used, no entry is required.

6. Enter the Analysis Services Instance Name.

NOTE  This field requires a value only when installing on MS SQL Server 2005 with a non-
default Analysis Service. If you are installing on MS SQL Server 2000 or installing on MS SQL 
Server 2005 with the default instance you can leave the field empty.

7. Verify that the folder where you store your reports is listed in the Report Folder field. 

NOTE  By default, the field contains the location where Setup installed the out-of-the-box 
reports. If your reports are stored in another folder, enter the path to this folder here. 

8. Click Configure.

The Client Configuration Tool configures the out-of-the-box reports by configuring the data 
connection in all Excel spreadsheets in all folders one level below the indicated folder. The 
progress of the configuration appears in the Results box.

NOTE Following configuration, on the PA client machine you can view and modify the sample 
reports or create new reports. For details, see the IBM FileNet P8 Help topic Expansion 
Products > Process Analyzer > Process Analyzer User Guide (also available on the client server by 
navigating to Start > Programs > FileNet P8 Platform > Process Analyzer > Process Analyzer 
User Guide).

9. Select File > Exit to close the Client Configuration Tool.
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Task 6: Install Process Analyzer Software Updates
Install any service packs, fix packs and/or interim fixes required for Process Analyzer. To 
determine whether such additional software updates are needed, contact your service 
representative.
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Upgrade Planning and Procedures

This upgrade section contains the following major topics:

• “Upgrade Overview” on page 35

• “Prerequisite Tasks” on page 37

• Task 1 “Upgrade Process Analyzer Documentation” on page 38

• Task 2 “Upgrade Process Analyzer Engine” on page 39

• Task 3 “(Optional) Upgrade MS SQL Server 2000 to version 2005.” on page 41

• Task 4 “Upgrade Process Analyzer Client” on page 43

• Task 5 “Install Process Analyzer Software Updates” on page 44
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Upgrade Overview
This section lists details that will help you prepare your environment for the upgrade of FileNet PA. 
In many cases, the items you see listed will be links to more detailed information, which will help 
you plan a system upgrade. Review this information thoroughly before you start to upgrade 
FileNet PA or required third-party software.

NOTE  The upgrades described in this guide assume that you will retain your basic platform 
configuration from the previous release.

Upgrade Planning Considerations 

Gather auxiliary documentation. 
For a list of required documentation, see “Gather Required Documentation” on page 10.

Supported Upgrade Paths
• See the FileNet P8 Hardware and Software Requirements document for the version numbers of 

product platforms supported for use with FileNet PA 3.5.2. 

• Before you upgrade your FileNet software, update your third-party software to the patch and 
Service Pack levels that FileNet supports.

CAUTION  If you plan to upgrade MS SQL Server from version 2000 to version 2005 you must 
do this after you have upgraded the Process Analyzer software.

FileNet Platform
• You must upgrade the FileNet P8 Platform core components: Content Engine (CE), Process 

Engine (PE), and Application Engine (AE), before you upgrade PA.

• You must upgrade PA before you upgrade Process Simulator (PS).

• You can upgrade to FileNet PA 3.5.2 from version 3.5.1 only.

CAUTION  Apply the required minimum level of FileNet PA patches to the currently 
installed software before you upgrade. FileNet patches and fix packs often include feature 
updates that are required to ensure a successful upgrade. Therefore, before you begin your 
upgrade to FileNet PA 3.5.2, you must have applied the minimum level of fix packs to your 
installed 3.5.1 components. For more details, see FileNet P8 Hardware and Software 
Requirements.

Database
FileNet PA 3.5.2 adds support for MS SQL 2005. 

CAUTION  If you plan to upgrade to MS SQL 2005 you must first upgrade your PA installation to 
version 3.5.2 and verify that the upgrade was successful.
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Gather Pre-upgrade Information

General Considerations
Note the FileNet P8 Platform Documentation URL. If you have an existing application server in 
place with a FileNet P8 Platform Documentation web site established, you can determine its URL 
by checking the Documentation server site preference in Workplace.

Database Engine
• Note your current Database Instance Names, NLS, and character set configurations. 

• Note the dedicated TCP/IP port number of the SQL Server database instance that PA Engine 
will use. 

To determine the TCP/IP port number, open SQL Server Enterprise Manager and display the 
database instance properties. Click Network Configuration on the General tab. Select TCP/IP 
in Enabled protocols and click Properties.
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Prerequisite Tasks
Before you start upgrading PA: 

1. Verify that the core platform components have been upgraded to the required Fix Packs.

PA requires that the three core platform components, Content Engine (CE), Process Engine 
(PE), and Application Engine (AE), have been upgraded and configured before starting the PA 
upgrade.

For more information, see the IBM FileNet P8 Hardware and Software Requirements. 

2. Verify that your existing version of PA is at a release version that supports upgrades to version 
3.5.2. 

See “Supported Upgrade Paths” on page 35. For further details, see the IBM FileNet P8 
Hardware and Software Requirements.

3. Ensure that you have installed/upgraded any necessary prerequisite software.

NOTE  You must upgrade Process Analyzer software before updating MS SQL Server to 
version 2005.

For more information, see the IBM FileNet P8 Hardware and Software Requirements. 

4. Back up the PA Engine.

Make sure the site has restorable backups of the system and data for all PA and Process 
Engine components. In case of an emergency, you might need to back out of the upgrade. For 
details on what to back up for FileNet P8 components, see the IBM FileNet P8 Help topic 
FileNet P8 Administration > Enterprise-wide Administration > Back up and Restore FileNet P8.

Back up the following items.

• The database used by Process Engine that this PA Engine is connected to.

• The VMAEDM database

• The analyzer.properties file (Default location:C:\Program Files\filenet\Process Analyzer 
Engine\jpa).

• The VMAE OLAP database. Make a note of any special configuration that has been applied to 
cubes or dimensions, such as role assignments or auto-grouping. The configuration must be 
reapplied after the upgrade is complete. See the online help for the Analysis Manager for 
information and detailed instructions on creating roles and assigning users. 

5. Disable tasks on the PA server, such as:

– Scheduled automated backups

– Virus scanning

6. Verify that the FileNet P8 Platform core components (CE, PE, AE) are running.

7. Verify that the existing Process Analyzer software is not running.

8. (If PE uses an Oracle database) Verify that the Oracle listener is running on the PE database 
server. 
IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE



Task 1: Upgrade Process Analyzer Documentation 38

IBM FILENET PROCESS ANALYZER INSTALLATION AND UPGRADE GUIDE

Task 1: Upgrade Process Analyzer Documentation 
Process Analyzer is an expansion product of IBM FileNet P8 Platform; therefore you must add the 
associated PA documentation to an existing installation of the IBM FileNet P8 Platform Help. This 
action makes PA help available to your users and enables context-sensitive help from the product 
user interface. 

For details and instructions on installing expansion product documentation, see the latest IBM 
FileNet P8 3.5 version of the IBM FileNet P8 Platform Installation and Upgrade Guide. Pay special 
attention to the “Install expansion product documentation” subtopic in the “Install IBM FileNet P8 
documentation (<your application server>)” task.

CAUTION  You can install only the 3.5.2 version of PA documentation on an existing IBM FileNet 
P8 Platform 3.5 documentation server. 
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Task 2: Upgrade Process Analyzer Engine
Prepare to upgrade Process Analyzer Engine

1. Stop Process Analyzer and disable the connection between Process Analyzer and Process 
Engine.

a. Open the Process Analyzer Task Manager by selecting Start > Programs > FileNet P8 Plat-
form > Process Analyzer > Process Task Manager.

b. Right-click on the Process Analyzer node and select Stop from the context menu.

c. Select the Advanced tab. 

d. Make note of the port number in the Data Port field and then set the field to an unused port 
number. Note that this field must be set to an integer and cannot be left blank.

e. Close the Task Manager by selecting File > Exit.

2. In Windows, navigate to Control Panel > Administrative Tools > Services and stop Process 
Analyzer Services Manager.

To upgrade Process Analyzer Engine

1. Ensure that the PA Engine database is running. 

2. Log on as the <PA Installer>. See, “Users required for Process Analyzer installation” on page 13.

3. Access the IBM FileNet Process Analyzer 3.5.2 software package.

4. Launch the Setup program (P8PA-3.5.2-Engine.exe, located in the PAEngine directory) to start 
the installation process.

In this screen... Perform this action...

License Agreement Review and accept the license agreement.

Detected FileNet BPM 
Software

Click Next to stop the software components and continue with 
the installation.

Backup Database Backup your database and then click Next.

Specify the 
Documentation URL

Enter the Documentation URL, which is where the FileNet P8 
Platform Documentation was installed. Your entry must be in the 
following format:

http://<docserver:port#>/<ecm_help>

where: 

• docserver is the name of the Java web server.

• port# is the port number.

• ecm_help is the root folder of the documentation website. 
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5. Upgrade the PA database. 

a. Open the Process Analyzer Task Manager by selecting Start > Programs > FileNet P8 Plat-
form > Process Analyzer > Process Task Manager.

b. Right-click the Process Analyzer node and select Start from the context menu.

c. If a database upgrade is required, a dialog will display.

d. Follow the dialog’s prompts to upgrade your database.

e. Backup the upgraded VMAEDM.

6. Enable the connection between Process Analyzer and Process Engine.

a. If it is not running, open the Process Analyzer Task Manager by selecting Start > Programs 
> FileNet P8 Platform > Process Analyzer > Process Task Manager.

b. Stop the Process Analyzer if it is running.

c. Select the Advanced tab. 

d. Set the Data Port field back to its original value. The default port number is 32772.

7. Reapply any special configuration that has been applied to cubes or dimensions, such as role 
assignments or auto-grouping.

8. Reprocess the OLAP cubes. See the procedure on “(Optional) Reprocess the OLAP cubes.” on 
page 42 for instructions. 

Installation Summary Read and verify the installation summary information. 

Click Next if the information is correct, or click Back to make 
changes.

Complete the Installation When the installation is complete and selected software has 
been started, click Finish to exit the installation program.

Specify Process 
Analyzer Usage 

Indicate whether PA will be used to:

• Analyze Production Data

• Analyze Production and Simulation Data.

In this screen... Perform this action...
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Task 3: (Optional) Upgrade MS SQL Server 2000 to 
version 2005.
1. Back up the upgraded PA database (VMAEDM).

2. Upgrade MS SQL Server 2000 to version 2005.

NOTE  You can perform this step any time after installing PA Engine. This version of PA Engine 
runs on both MS SQL 2000 and MS SQL 2005. You might want to verify the functionality of the 
updated PA Engine before upgrading the database.

a. Stop Process Analyzer software, if running.

b. Follow Microsoft instructions to upgrade the database from MS SQL Server 2000 to MS SQL 
Server 2005.

CAUTION  When upgrading a named instance of MS SQL Server don't select to upgrade 
Analysis Services on the Components to Install screen. To upgrade the default instance of 
Analysis Services used by Process Analyzer you must run the SQL Server 2005 setup a 
second time, this time selecting to upgrade the default instance and choosing the Analysis 
Services component.

c. Download and install the Microsoft SQL Server 2005 JDBC driver.

d. Delete the existing Process Analyzer OLAP database.

i. Go to Start > Programs > Microsoft SQL Server 2005 > SQL Server Management Studio.

ii. Connect to the Analysis Services instance used.

iii. Expand Databases. 

iv. Right click the OLAP database (VMAE_<db_instance_name>) and select Delete.

NOTE  If you are using the default instance, no instance name is appended.

v. Click OK to delete the database.

e. Rebuild the OLAP database and update the PA configuration

i. Open a command prompt

ii. Change directories to:

C:\Program Files\FileNet\Process Analyzer Engine\jpa\scripts\sqlserver\2005

iii. Run the script upgradeconfig.bat.

iv. The upgradeconfig script will display a dialog. Enter the Microsoft SQL Server 2005 
JDBC classpath and click OK.

3. Reapply any special configuration that has been applied to cubes or dimensions, such as role 
assignments or auto-grouping.
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4. (Optional) Reprocess the OLAP cubes.

This optional operation will provide you with the OLAP report data before the next scheduled 
run of the report. Note that this operation could take a long time. IBM FileNet recommends 
that you perform it during periods of low usage.

a. On the PA server, navigate to Start > Programs > FileNet P8 Platform > Process Analyzer > 
Process Task Manager.

b. Start the Process Analyzer services from the Process Task Manager by right-clicking Pro-
cess Analyzer and selecting Start.

c. Right-click the Process Analyzer node again and select Process Cubes.

d. Click Yes to confirm that you want to proceed with the reprocessing.
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Task 4: Upgrade Process Analyzer Client
For software requirements for the PA Client and third party tools such as MS Excel, see the IBM 
FileNet P8 Hardware and Software Requirements document. 

To upgrade Process Analyzer Client

1. Backup reports.

Before you uninstall the previous client you should create backup copies of your existing 
custom reports that are stored in the default path (the installation location you selected when 
installing the PA Client). All files in this path will be overwritten by the client installer.

Default: C:\Program Files\FileNet\Process Analyzer Client\ootbreport  

2. Uninstall PA Client version 3.5.1.

a. On the PA client server, navigate to Start > Settings >Control Panel and then double-click 
Add/Remove Programs.

b. Select the FileNet Process Analyzer Client application from the list of installed programs and 
click Change/Remove.

c. Click Yes to confirm you want to remove the PA Client application.

d. Click OK when the Uninstall program is finished.

e. Close the Add/Remove Programs snap-in.

f. Close the Control Panel.

3. Install PA Client version 3.5.2

a. To install PA Client, follow the instructions in Task 5 “Install Process Analyzer Client” on 
page 29.

b. To install required PA 3.5 software updates, follow the instructions in “Install Process Analyzer 
Software Updates” on page 33.
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Task 5: Install Process Analyzer Software Updates
Install any service packs, fix packs and/or interim fixes required for Process Analyzer. To 
determine whether such additional software updates are needed, contact your service 
representative.
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Remove Software

This section presents steps for removing PA Engine and PA Client. 

To remove Process Analyzer Engine

1. On the PA Engine server, navigate to Start > Settings > Control Panel and double-click Add/
Remove Programs.

2. Select the FileNet Process Analyzer Engine application from the list of installed programs and 
click Change/Remove.

3. Click Next at the Welcome screen.

4. Click Next to stop the FileNet BPM software and continue with the wizard.  

5. Click Next when you see the list of software components to be removed.

6. Click Yes to remove the PE Help URL, taskman.properties, and analyzer.properties files.

7. Click Finish to exit the wizard.

NOTE  Depending on the state of the system, you might be prompted to restart the computer 
in order to complete the uninstall process. Click Finish.

8. Close the Add/Remove Programs snap-in.

9. Close the Control Panel.

To remove Process Analyzer Client

1. On the PA Client server, navigate to Start > Settings >Control Panel and then double-click Add/
Remove Programs.

2. Select the FileNet Process Analyzer Client application from the list of installed programs and 
click Change/Remove.

3. Click Yes to confirm you want to remove the PA Client application.

4. When the Uninstall program is finished, click OK.

5. Close the Add/Remove Programs snap-in.

6. Close the Control Panel.
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Notices
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
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BM Corporation
46A/G4
55 Bailey Avenue
an Jose, CA 95141-1003
.S.A.

uch information may be available, subject to appropriate terms and conditions, including in some cases,
ayment of a fee.

he licensed program described in this document and all licensed material available for it are provided
y IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
ny equivalent agreement between us.

ny performance data contained herein was determined in a controlled environment. Therefore, the
esults obtained in other operating environments may vary significantly. Some measurements may have
een made on development-level systems and there is no guarantee that these measurements will be the
ame on generally available systems. Furthermore, some measurements may have been estimated through
xtrapolation. Actual results may vary. Users of this document should verify the applicable data for their
pecific environment.

nformation concerning non-IBM products was obtained from the suppliers of those products, their
ublished announcements or other publicly available sources. IBM has not tested those products and
annot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
roducts. Questions on the capabilities of non-IBM products should be addressed to the suppliers of

hose products.

ll statements regarding IBM’s future direction or intent are subject to change or withdrawal without
otice, and represent goals and objectives only.

his information contains examples of data and reports used in daily business operations. To illustrate
hem as completely as possible, the examples include the names of individuals, companies, brands, and
roducts. All of these names are fictitious and any similarity to the names and addresses used by an
ctual business enterprise is entirely coincidental.

OPYRIGHT LICENSE:

his information contains sample application programs in source language, which illustrate programming
echniques on various operating platforms. You may copy, modify, and distribute these sample programs

any form without payment to IBM, for the purposes of developing, using, marketing or distributing
pplication programs conforming to the application programming interface for the operating platform for
hich the sample programs are written. These examples have not been thoroughly tested under all

onditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
rograms.
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Trademarks
Trademarks

 

IBM is a registered trademark of International Business Machines Corporation in the United States, other
countries, or both.

The following terms are trademarks of the International Business Machines Corporation in the United
States, other countries, or both:

IBM FileNet ibm.com

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names may be trademarks or service marks of others.
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